
- 1 - 
 

 

 
 As 2021 draws to a close, 
the library staff and I wish all our 
patrons and the entire Valley 
Stream community a happy new 
year in 2022.   At the start of 
2021, the library was limited to 
curbside/pick-up visits, virtual 
programming, and reduced 
hours.  But as the year 
progressed, we opened our doors 
to limited browsing visits, 
outdoor children’s programming, 
and expanded hours.  
 

Patrons are now able to 
visit, to sit and read newspapers 
and magazines, to use public 
access computers, and to study.  
We are open to 8 pm for four 
nights a week, although we have 
not resumed Sunday hours yet.  
Limited in-person programs are 
being held in the Children’s 
Room, with masking required for 
children and adults.   

 
 

 

 
The library continues to 

return to pre-COVID operations,  
but we are faced with another 
year of uncertainty with the new 
omicron variant. Patrons who 
wish to enter the library must use 
the Adult Room Entrance, where 
a security guard will conduct 
temperature checks, check for 
face masks (and distribute them 
as needed), and monitor visitors. 
Social distancing should be 
observed for everyone’s safety, 
and of course, masking is 
required.  Curbside pickup 
service is still available at the 
Children’s Room Entrance. 

 

 
 
 

 
We hope that 2022 will 

bring an end to the pandemic so 
that our lives can return to 
normal.  Meanwhile, we hope to 
see you back at the library to 
borrow books, to attend 
programs virtually or in-person, 
or to just stop by to say hello!   
 

Please stop by or call the 
Reference Department if you 
need help to locate books, to use 
any of our online resources, to 
borrow a family museum pass, or 
to ask about any of our programs 
and services. 

 
Call or contact Children’s 

Librarian Ms. Kunz at 
kidsroomvs@nassaulibrary.org to 
see what programs and activities 
she has planned for your 
chiildren.  Teen Librarian Ms. 
Kenney can be reached at 
VSteens@nassaulibrary.org for 
programs for teens. 
 
 So, make a resolution to 
visit the library soon.  We are 
looking forward to seeing you in 
2022! 
 
 Mamie Eng 

 Library Drector 
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DECEMBER HOLIDAY 

CLOSINGS 

 

Christmas Eve 

Friday, December 24 
Library Closes at 1 pm 

Christmas Day  

Weekend 

Saturday, December 25 

– Sunday, December 26 
Library Closed 

Library reopens on Monday, 

December 27, 2021, at 10 am. 

 

 

New Year’s Eve 

Friday, December 31 
Library Closes at 1 pm 

New Year’s Day  

Weekend 

Saturday, January 1 – 

Sunday, January 2 
Library Closed 

Library reopens on Monday, 

January 3, 2022, at 10 am. 

 

 

COMPUTER CLASSES 

VIA ZOOM 

 

The library will be 
holding various basic computer 
classes via Zoom on various 
Saturday mornings at 10 am: 
 
January 8, 2022 –  
Microsoft Word Basics: 
What’s on the Home Tab?, Pt. 1 
 
January 15, 2022 –  
Microsoft Word Basics: 
What’s on the Home Tab?, Pt. 2 
 

 
 
January 22, 2022 –  
Microsoft Word Basics: 
What’s on the Layout Tab? 
 

 
 
January 29, 2022 –  
Microsoft Word Basics: 
What’s on the Insert Tab? 
 
 You can attend all or any 
of the classes, depending on your 
schedule. 
 

Contact Director Ms. Eng 
at hwmlcontact@hotmail.com 
for the Zoom information to 
attend the class. 
 

 
 
 

PUBLIC ACCESS 
COMPUTERS ARE 

BACK 
 

 
 

The library has two 
public computer stations (socially 
distant) available for use in the 
Adult Room for a maximum 
session of 1 hour.  One station is 
available in the Children’s Room 
for a maximum session of 30 
minutes.  Patrons can come in to 
see if a computer is available or 
reserve a specific time. 
 
 Only one reservation can 
be made per day per patron.  
Reservations will be held for 10 
minutes (which will count as part 
of the hour), and then the 
computer will be released to the 
next patron waiting for a 
computer. 
 
 Due to health safety 
concerns, the staff will only 
provide limited computer 
assistance. Hand sanitizer and 
wipes are available for patron 
use. 
 

 
 
             You can use your library 
card to sign up for a computer or 
can be issued a visitor’s pass to 
use a computer. 
 
 

mailto:hwmlcontact@hotmail.com
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LIBRARY HOURS 

FOR LIBRARY VISITS  
 

MON 10am – 8pm 
TUE 10am – 8pm 
WED 10am – 7pm  
THU 10am – 8pm 
FRI 10am – 8pm 
SAT 10am – 4pm 

 

PLEASE USE ADULT ROOM 
ENTRANCE FOR  
LIBRARY VISITS. 

 
You must use the Adult 

Main Entrance for in-person 
library visits as temperature 
checks are still being taken when 
you enter the library.  Remember 
that face masks or coverings are 
required. 

 
Tables and chairs are 

now available in the Adult Room 
and Children’s Room. At the 
present time, a maximum of 25 
visitors are permitted in the 
library at the same time.  If 
necessary, library visits may be 
limited to 1 hour. 
___________________________ 

 

FOR CURBSIDE/LOBBY 
SERVICE  

  
If you are uncomfortable 

about coming into the library to 
browse or like the convenience 
of having your materials ready 
for a quick pickup, 
curbside/lobby service will 
continue to be available at the 
Children’s Room Entrance only.   

 
MONDAYS-FRIDAYS 

10:00 am – 6:00 pm 
 

SATURDAYS 
10:00 am – 4:00 pm 

 
 
 During the past year of 
the COVID pandemic, the need 
for Internet access was a high 
priority for most people to stay in 
touch with families and friends, 
for children to attend virtual 
classes, for people to order 
groceries, and for people to work 
from home.  However, not 
everyone had dependable 
Internet access. 
 
 The Henry Waldinger 
Memorial Library is pleased to 
announce that it has partnered 
with other libraries in Nassau 
County to participate in WiFi 
Whenever.   
 

WiFi Whenever is a 
county-wide project initiated by 
the Nassau Library System to 
boost Internet access outside 
library buildings such as ours.  
The project is supported with 
federal Coronavirus Aid, Relief, 
and Economic Security (CARES) 
Act funds allocated to the New 
York State Library by the Institute 
of Museum and Library Services 
(IMLS). 
 
 The Meraki MR86 Wi-Fi 
6 Outdoor Access Point mounted 
on the front right corner of the 
library building boosts the 
library’s WiFi range by up to 300+ 
ft., allowing people in nearby 
housing, on the Village Green, or 
parking areas to have free 
internet access whether the 
library is open or not.   
 

Look for the library’s 
network name in your Wi-Fi 
settings on your phone, 

tablet, or computer.  There is no 
password.  If you do not see it in 
your network settings, try 
moving closer to the library.  
 

Contact Director Ms. Eng 
at hwmlcontact@hotmail.com 
for additional information about 
WiFi Whenever. 

 
 

 
 

___________________________ 
 

DONATIONS  
TO THE LIBRARY 

 

The library would 
appreciate it if all book donations 
were placed in the two Better 
World Books bins at the rear of 
the parking lot to the right of the 
building.   If the bins are full, do 
not leave the donations outside 
the bins.  If they get wet, they 
cannot be used and they end up 
in the dumpsters! 

 

 
 

Please do not leave 
donations on the Children’s 
Room Entrance landing.  Books 
left there will be picked up by the 
Valley Stream Sanitation 
Department. 

 

mailto:hwmlcontact@hotmail.com


- 5 - 
 

ONLINE MAGAZINES  
ON LIBBY 

 

 
 

 Online magazines, 
supplied by Zinio, are now 
available using the Libby app!   
 
 Magazines have a 
checkout period of 21 days.  
There is no wait time, no 
reserves, and no limit to the 
number of times a magazine can 
be checked out.  There should be 
no delay in getting the latest 
issue of a magazine. Checkouts of 
magazines will not count toward 
NDD limits.   
 

 
 

Contact the Adult 
Reference Desk for further 
information about online 
magazines!    

 
 

WIFI HOTSPOTS  
AVAILABLE FOR LOAN 

 

 
 
 The library is pleased to 
announce that Valley Stream 
library patrons can now borrow a 
T-Mobile Franklin T-9 mobile 
hotspot for a 14-day loan period!  
The hotspot may be renewed for 
another 14-day period if there is 
no waiting list for it. 
 

This WiFi hotspot is a 
device that you can use to 
connect a mobile-enabled device, 
such as a laptop smartphone or 
tablet, to the internet.  It is 
portable, so you can connect 
your device almost wherever you 
are – at home, on bus or train, or 
in the park. And when you are on 
vacation! 

 
Borrowers must sign a 

Borrowing Agreement form and 
provide a valid adult Valley 
Stream library card in good 
standing.  In addition, as with our 
family museum passes, all family 
members must be in good 
standing as the portable hotspot 
can accommodate up to 15 
devices in your home at the same 
time. 

 
The late fee is $5.00 per 

day, and a $100 replacement fee 
is billed after 10 days overdue, 
plus internet service will be 
turned off if a hotspot is not 
returned on the due date. 

 

T-Mobile Franklin T-9 
mobile hotspots were purchased 
with a Special Legislative Grant 
awarded to the Henry Waldinger 
Memorial Library by New York 
State Senator Todd Kaminsky 
(S.D. 9).  Without this grant, the 
library would not have been able 
to purchase multiple devices to 
loan to our patrons, so we are 
very grateful for his generosity to 
the community. 

 
Some patrons have 

taken advantage of the WiFi 
hotspots when they have had 
disruptions in their Internet 
service, when they have been on 
vacation, or when they have 
travelled to an area where 
Internet service is spotty.    
Remember, there is no charge to 
borrow a hotspot (if you return it 
on time) for free WiFi access! 

 
Contact Library Director 

Ms. Eng for further information 
at hwmlcontact@hotmail or 516-
825-6422.  Depending on 
availability, you can reserve to 
borrow a WiFi hotspot if you are 
planning a vacation or trip out of 
town where Internet access may 
not be available. 

 
 

 
 

 

 
 
 
 

mailto:hwmlcontact@hotmail.com
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ANCESTRY.COM  
HOME USE ENDS ON 

DECEMBER 31st 
 
 

Have you ever 
considered doing genealogical 
research about your family?  
ProQuest has given Valley Stream 
library patrons free home access 
to Ancestry.com. Normally, 
library access is limited to an in-
library research computer, and 
individual basic subscription to 
ancestry.com for one year is 
$189.99, so this is a great deal! 
 

Free home access will be 
ending at the end of the year, so 
take advantage of this 
opportunity to delve into your 
ancestors by clicking on the 
ProQuest/Ancestry link on the 
library webpage at 
http://www.valleystreamlibrary 
.org, and then entering your 
library barcode number.   

 
will have access to U.S. 

Census Records from 1790 to 
1940; birth, death, and marriage 
records; military records; 
immigration and emigration 
records; directories; and much 
more. 
 

 
 

This is a great 
opportunity for you to see who is 
in your family tree.  This free 
access will NOT be extended 
beyond December 31, 2021, so 
do not delay about starting on 
your research today.  If you need 
help with ancestry.com, 

Reference Librarian Ms. Levin has 
created an information sheet to 
help you use ancestry.com.  It is 
available at: 
 
https://www.valleystreamlibrary.o
rg/Ancestry.com%2004.17.20.pdf 

 

 
If you require additional 

help, please let us know.  Call the 
Adult Reference Desk at 516-825-
6422 during library hours from 10 
am-8 pm on Mondays, Tuesdays, 
Thursdays, and Fridays, from 
10am-7pm on Wednesdays, or 10 
am-4 pm on Saturdays. 
___________________________ 
 

DAILY NEWSPAPERS  
AVAILABLE 

 

 
 
Daily newspapers are 

now available to the public!  At 
the current time, the library is 
not be requiring identification or 
a library card to read the 
newspapers on a trial basis.  
Please return newspapers to the 
newspaper rack for the next 
patron to read. 

 
 

 

 
 

 
 
 

DIGITAL LIBRARY CARDS 
STILL AVAILABLE 

 Do you need a digital 
library card?  The application for 
the digital library card is available 
through the Nassau Library 
System at: 

https://www.nassaulibrary.org/ 
coronavirus-information/ 
digital-card-application/. 

 
Digital library cards are 

still being issued even though the 
library is open for library visits 
and curbside/lobby service.  With 
it, patrons can borrow e-books 
and e-audiobooks, stream Qello 
concerts, and use various 
databases and services. 
 

 
 
During the past year, 

over 650 Valley Stream people 
applied for and were issued 
digital library cards and took 
advantage of the digital 
resources available to them.  The 
number of e-books borrowed 
through the Nassau Digital 
Doorway and Libby across the 
county exceeded 1,000,000 last 
year and will probably be close to 
2,000,000 in 2021.  

 
Previously issued digital 

cards can be renewed for 
another four months.  New 
digital cards will be issued for 
four months only.  So, you can 
still take advantage of the various 
online services available to you 
even if you cannot visit the 
library for a physical library card 
with the digital cards. 

http://www.valleystreamlibrary/
http://www.valleystreamlibrary.org/
https://www.valleystreamlibrary.org/Ancestry.com%2004.17.20.pdf
https://www.valleystreamlibrary.org/Ancestry.com%2004.17.20.pdf
https://www.nassaulibrary.org/
https://www.nassaulibrary.org/coronavirus-information/%20digital-card-application/
https://www.nassaulibrary.org/coronavirus-information/%20digital-card-application/
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ENCORE VIRTUAL 
AUTHOR VISITS 

 Did you know that the 
Valley Stream Book Club has 
been meeting each month 
during the past year or so via 
Zoom?  The virtual meetings 
are usually held on the last 
Tuesday of the month at 7:30 
pm. 

 The library obtains 
copies of the book to be 
discussed that month, plus 
provides a reading guide of 
discussion questions and 
additional information about 
the author or the book. 

 Some of the books that 
have been discussed during the 
past year include House of 
Thieves, by Charles Belfoure; 
Kindred, by Octavia E. Butler; 
The Only Woman in the Room, 
by Marie Benedict; and Eleanor 
Oliphant Is Completely Fine, by 
Gail Honeyman. 

 In some cases, the book 
club has enjoyed virtual visits 
via Zoom, and those meetings 
have been especially well-
received.  Some of the authors 
who have visited are Yona 
Zeldis McDonough, Sheila 
Roberts, and Amy Stewart.  
Recordings of the author visits 
with Ilona Bannister (When I 
Ran Away) and Shana Abé (The 
Second Mrs. Astor) are available 
upon request.  Contact Ms. Eng 
at hwmlcontact@hotmail.com 
for the links to the recordings. 

 

CHECK OUT  
THE SEED LIBRARY 

 
 

 
 
Take advantage of the 

FREE seed exchange station that 
has been set up by Local Seed 
Savers at the library.  Seed 
donations are welcome! 

 
Check out the Facebook 

page for Local Seed Savers at 
https://www.facebook.com/grou
ps/702052477137840.  The goal 
of this group is to connect home 
gardeners and local seed savers. 
Seed saving is necessary for 
preserving heirloom seeds and 
creating new hybrid varieties 
with favorable traits. Local seeds 
can be adapted to your climate 
and help others in your area 
grow more food. 
___________________________ 
 

LIBRARY LINKS  
IS BI-WEEKLY 

 

  
 

Library Links, the 
library’s online newsletter, is 
being published on a bi-weekly 
basis.  Back issues are archived 
on the Valley Stream library’s 
website at: 

 

https://valleystreamlibrary.org. 

LEARN TO CODE 
CLASSES - 

STEM ACTIVITIES 
 

 The library is pleased to 
announce that a new Learn to 
Code Classes will be offered in 
2022 on various Saturdays at 
11:30 am. Our volunteer teacher 
Sawaira will be back to teach new 
classes with a focus on STEM 
activities: 
 

 Canva 

 Tinkercad circuits 

 Vision boards 

 Stop motion animation 

 3D art 

 Scratch & Scratch Jr. 
 

 
 

Tinkercad Circuits 

 
Children, Grades 3-6, are 

welcome to attend these classes. 

 

To register for the Learn 
to Code classes, contact Library 
Director Ms. Eng at 
hwmlcontact@hotmail.com and 
the Zoom information will be 
sent to you.  The next session will 
be on January 8, 2022, at 11:30 
am. 

 
 

 
 
 

 

mailto:hwmlcontact@hotmail.com
https://www.facebook.com/groups/702052477137840
https://www.facebook.com/groups/702052477137840
https://valleystreamlibrary.org/
mailto:hwmlcontact@hotmail.com
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IMPROVEMENTS 
TO LIBBY 

 

 
 
Remember to take 

advantage of the Nassau Digital 
Doorway and download e-books, 
e-audiobooks, and e-magazines 
using the Libby app.  Plus, you 
can now stream movies from 
IndieFlix or concerts from Qello 
via the Nassau Digital Doorway or 
Libby. 

 
If you have been using 

Libby to download e-books, e-
audiobooks, or e-magazines, you 
will be happy to learn that in 
early January 2022, OverDrive 
will be updating Libby to include 
several changes to improve the 
app’s accessibility for all users. 

 
Full screen menus: 
The in-app menu will no longer 
open from the side of the app. 
Instead, it will fill the screen. It 
will still have Libby’s familiar look 
and feel. This will make keyboard 
and screen reader navigation 
more consistent and help you 
concentrate on the task you are 
trying to perform in the menu. 
 
Menu icon: 
The menu button in the 
navigation bar will be simplified 
to three horizontal bars, which is 
a familiar icon common in other 
apps and across the web 

New accessibility features: 
Several accessibility improve-
ments will help you to better 
navigate Libby with assistive 
technologies like screen readers. 
OverDrive has refined the 
invisible labels and descriptions 
on all interactive elements, 
streamlined the presentation of 
information to screen There have 
been upgrades to Libby from the 
vendor to improve its encryption 
security since September 2021. 

 
Users on legacy web 

browsers may experience issues 
loading libbyapp.com or your 
OverDrive website and should 
upgrade to a newer browser 
version, if possible. 

 
Users may experience 

issues with signing in, borrowing, 
loading the app’s content, etc.  
For more information and 
troubleshooting tips, check out 
Libby Help  and OverDrive Help.  

 
If you have any 

questions about Libby, contact 
the Adult Reference Desk for help 
at 516-825-6422 or 
hwmlrefdesk@nassaulibrary.org.  
Or check out the Libby guide on 
the library webstie at 
https://www.valleystreamlibrary.

org/Libby%20-%2003192020.pdf. 
 

 
 

 

 

MORE & MORE 
WONDERBOOKS  

 
Have you tried a 

Wonderbook yet?  Each 
Wonderbook is a print book with 
a ready-to-play audiobook inside.  
Kids can press the “Play” button 
to read along with their favorite 
books on their own.  

 

 
 

Some of the 
Wonderbook titles available 
include Corduroy, by Dan 
Freeman; Frog and Toad 
Together, by Arthur Lobel; Big 
Nate books, by Lincoln Peirce; 
Amelia Bedelia books, by Herman 
Parish; and The Cricket in Times 
Square, by George Selden.   

 
Since last year, the library 

has added almost 100 new 
Wonderbook titles, including 
popular chapter books such as 
Junie B. Jones and the Yucky Blucky 
Fruitcake, by Barbara Park; Big 
Nate In a Class By Himself, by 
Lincoln Peirce, and Captain 
Underpants and the Perilous Plot of 
Professor Poopypants, by Dav 
Pilkey. 

 
If you are interested in 

receiving a current list of all the 
titles available, contact Library 
Director Ms. Eng at 
hwmlcontact@hotmail..com and 
the list will be e-mailed to you for 
you to browse at your 
convenience.  Select your titles 
and place holds for them or call 
the Reference Department with 
your selections. 

http://libbyapp.com/
https://click.e.overdrive.com/?qs=5f635cebec9bc7594b46bf2527465e09221547bf4a334943d6c469fe615c2b529bf3e1e8f35f60612c6439567c75daae87fd949770ec4368
https://click.e.overdrive.com/?qs=5f635cebec9bc75910f04a2779d59210d054a45e274c82660a98ddbbfc5518978036caed1eb1e57224d6f6e47ff9ef87a9f74c0ca57d3f19
mailto:hwmlrefdesk@nassaulibrary.org
https://www.valleystreamlibrary.org/Libby%20-%2003192020.pdf
https://www.valleystreamlibrary.org/Libby%20-%2003192020.pdf
mailto:hwmlcontact@hotmail..com
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TAKE ADVANTAGE OF 
FAMILY MUSEUM 

PASSES 
 

Library patrons are 
reminded to take advantage of 
the library’s family museum 
passes.  Families can visit various 
museums or gardens for FREE 
and, in many cases, avoid lines! 

 
Please note that most 

museums require that visitors be 
vaccinated.  Check their websites 
for the latest policies and 
restrictions on visits.  In addition, 
many museums have revised 
hours. 

 
The library has just 

added a new family museum 
pass for Valley Stream 
cardholders – Vanderbilt 
Museum, located in Centerport, 
LI. 

 
 

 
 
 
 

 
The library’s family pass 

allows free general admission for 
two adults and four children 
under the age of 18. General 
admission gives visitors access to 
the Grounds, the first floor of the 
Hall of Fishes marine museum; 
the Habitat and Stoll Wing animal 
dioramas; and the natural-history 
and cultural-artifact galleries on 
the first floor of the Memorial 
Wing.   

 
The average savings per 

family of five visiting the 
museum is approximately $55.   

There is an additional fee to visit 
the planetarium. 

 
Another new pass for 

the library is the Nassau County 
Firefighters Museum pass. It 
allows free admission for up to 
four visitors.  The Nassau County 
Firefighters Museum is open 
daily Tuesday through Sunday 
from 10:00 am to 5:00 pm and 
open Mondays that fall on 
holidays and school breaks.   
 

 
 

The Intrepid Sea, Air, and 
Space Museum is now open 
seven days a week from 10 am to 
4 pm.    Library membership pass 
visitors no longer have to made 
advance reservations for visits.   

 
While some experiences 

will be temporarily closed during 
the initial reopening phase, the 
vast majority of the 350,000 
square foot Museum will be 
accessible to visitors, including 
most exhibitions like the entire 
collection of aircraft outside 
on Intrepid’s flight deck and in 
the spacious hangar deck, as well 
as the Space Shuttle Pavilion, 
which houses the space shuttle 

Enterprise.  
 

 
 
 If you are interested in 
visiting the New York Botanical 
Garden’s Holiday Train Show 
exhibition, you can take 
advantage of the library’s 

institutional membership for 
reserve time-entry tickets.   

 

 
 
 Old Westbury Gardens 
reopened in the spring, and 
tickets must be purchased in 
advance.  However, visitors with 
valid library pass holders do not 
need to make reservations in 
advance to visit.  The Gardens 
are open Mondays, 
Wednesdays, Thursdays, and 
Fridays from 11 am-6 pm, and 
on Saturdays and Sundays from 
10 am-5 pm.  It is closed on 
Tuesdays. 
  

MUSEUM ALERT:  The 
New York Hall of Science is 
temporarily closed due to 
damage that it sustained from 
Tropical Storm Ida.  We will let 
you know when they reopen to 
the public. 
 
 The Brooklyn Botanic 
Garden will be presenting 
Lightscape, an after dark, 
illuminated spectacular show, 
from November 19, 2021, to 
January 9, 2022.  Discounts are 
available with the library’s 
membership pass to Lightscape. 
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Other popular passes 
that are available include: 

 

 Long Island Children’s 
Museum 

 Cradle of Aviation Museum 

 Garvies Point Museum & 
Preserve 

 Clark Botanic Garden 

 New York Transit Museum 

 Nassau County Museum of 
Art 

 Cold Spring Harbor Fish 
Hatchery 

 
Call the Adult Reference 

Desk to find out which passes are 
available and to reserve a pass.  
Museum and garden hours have 
changed due to COVID, and new 
rules are in place for the safety of 
all visitors. 
___________________________ 
 

NEW NASSAU LIBRARIES 

HEALTH SHARE 

PROGRAMS 

 

 
  

The Henry Waldinger 
Memorial Library has joined 
Nassau Libraries Health Share!  
This is a consortium of libraries 
that are working together to 
share and promote quality health 
and wellness information and 
programs for the general public.  
By working together, we hope to 
reach the widest audiences 
possible for these educational 
opportunities. 

Here are some of the 
programs that are being 
promoted by Nassau Libraries 
Health Share for upcoming 
weeks: 
 

 Thursday, January 6, 2022, 
6:30 pm (VIA ZOOM):    
Prostate Health with 
Northwell Health’s Dr. Adam 
Cole.  Save your spot! 

 

 Monday, January 10, 2022, 1 

pm (VIA ZOOM):      Start the 

New Year with Meditation.  

The New Year is a time to 

create a clean slate.  Arlene 

Samsel has been inspiring 

audiences to bring joy, 

peace, positivity and 

relaxation into our daily lives, 

so let's begin the New Year 

with a fresh start!   Save your 

spot!  

 

 Wednesday, January 19, 

2022, 12 pm (VIA ZOOM):   

Stony Brook Cancer Center 

Health Education Series:  

HPV, Human Papilloma 

Virus.  Know the Facts!  

Learn about HPV, causes and 

symptoms, and screening 

recommendations. Save your 

spot!   

 

 Wednesday, January 19, 

2022, 7 pm (VIA ZOOM):   

Optimize Your Immune 

System: Combat Viruses and 

Age Gracefully with a Kitchen 

Pharmacy.  Save your spot!   

 

 Wednesday, January 26, 

2022, 2 pm (VIA ZOOM):   

Meditation for Inner Peace 

in the New Year: Join Jim 

Rose on a journey of finding 

lasting peace, happiness and 

a greater sense of well-being 

by learning a simple 

technique of spiritual 

meditation (explained and 

practiced during the 

session).  Save your spot!  

 
___________________________ 

 

 

 

Tutor.com is a fully 
online tutoring service. You can 
get a tutor 24/7 in more than 40 
subjects including Math, Science, 
Social Studies, English, AP ® 
Support, Foreign Languages and 
Business. This service is available 
for FREE to any Valley Stream 
library card holder. 

 

Tutoring sessions take 
place in an easy-to-use online 
classroom through a web 
browser.  Set up an account 
today using your library card bar 
code to start using Tutor.com. 

 

Tutor.com is available 24 
hours a day, seven days a week, 
361 days a year — the service is 
closed on New Year's Day, 
Independence Day, Thanksgiving, 
and Christmas Day. 

 

REMINDER:  Tutor.com's 
live tutors will not be available on 
Christmas Day (12/25) and New 
Year’s Day (1/1).  The Skills 
Center resources, however, will 
continue to be available 24/7 
throughout the holidays. 

 

https://www.eventkeeper.com/code/ekform.cfm?curOrg=HILLSIDE&curID=540840&CFID=32655489&CFTOKEN=ed98bacf33071f5a-0839A1FD-D4AE-528A-5350A88FD0E2C88C
https://www.eventkeeper.com/code/ekform.cfm?curOrg=HILLSIDE&curID=535714&CFID=32655489&CFTOKEN=ed98bacf33071f5a-0839A1FD-D4AE-528A-5350A88FD0E2C88C
https://www.eventkeeper.com/code/ekform.cfm?curOrg=HILLSIDE&curID=535714&CFID=32655489&CFTOKEN=ed98bacf33071f5a-0839A1FD-D4AE-528A-5350A88FD0E2C88C
https://www.eventkeeper.com/code/ekform.cfm?curOrg=HILLSIDE&curID=550229&CFID=32845141&CFTOKEN=70e8a2ad21c07c93-712C8D12-D4AE-528A-5350410940BE9C6D
https://www.eventkeeper.com/code/ekform.cfm?curOrg=HILLSIDE&curID=550229&CFID=32845141&CFTOKEN=70e8a2ad21c07c93-712C8D12-D4AE-528A-5350410940BE9C6D
https://www.eventkeeper.com/code/ekform.cfm?curOrg=HILLSIDE&curID=524385&CFID=32655489&CFTOKEN=ed98bacf33071f5a-0839A1FD-D4AE-528A-5350A88FD0E2C88C
https://www.eventkeeper.com/code/ekform.cfm?curOrg=HILLSIDE&curID=537716&CFID=32655489&CFTOKEN=ed98bacf33071f5a-0839A1FD-D4AE-528A-5350A88FD0E2C88C
http://www.tutor.com/subjects
http://www.tutor.com/subjects
http://www.tutor.com/
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COMMUNITY NEWS 
 

 
NASSAU COUNTY  

COMMUNITY RESOURCE GUIDE 
 

The Nassau County Courts has recently created a 
guide to assist the community in accessing resources 
available through the court system.   It can be 
accessed at:  
 
https://www.nassaubar.org/wp-
content/uploads/2021/09/Resource-Guide-PDF.pdf 
 

 
 
__________________________________________________________ 

 
RETIRED SENIOR VOLUNTEER 

PROGRAM 
 
The Retired Senior Volunteer Program is requesting 
laptop donations through their Community Computer 
Connections Program (CCCP). CCCP provides free, 
internet-ready computers to low-income 
individuals/families, veterans and Active Military 
Reservists across Long Island who would otherwise 
not be able to have access to this vital tool of today’s 
society. Computers are now a necessity because 
schools and job skills require familiarity with 
computers and the internet. 
 
Contact the Community Computer Connections 
Program (CCCP) to make donations or for further 
information: 
 

cccp.consultant@gmail.com 
 
 
 
 

 

 
NYS LAUNCHES  

NEW COVID-19 DATA WEB 
 

 
 
Gov. Kathy Hochul announced the launch of a new 
centralized website for New York State COVID-19 data. 
The one-stop website features data on testing, cases, and 
variants, hospitalizations and fatalities, vaccines, long-
term care facilities, and schools. Users can sort New York 
State Department of Health data by age, gender, 
race/ethnicity, facility, and county. 
 
https://coronavirus.health.ny.gov/covid-19-data-new-york 

 

_______________________________________________ 
 

 

https://www.nassaubar.org/wp-content/uploads/2021/09/Resource-Guide-PDF.pdf
https://www.nassaubar.org/wp-content/uploads/2021/09/Resource-Guide-PDF.pdf
mailto:cccp.consultant@gmail.com
https://coronavirus.health.ny.gov/covid-19-data-new-york
https://coronavirus.health.ny.gov/covid-19-data-new-york
https://coronavirus.health.ny.gov/covid-19-data-new-york
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VILLAGE UPDATES 
 

 

 

 
 

Attention Village residents! Call now if you are 

interested in a new curbside tree! 

 

Quantities are limited! Call 516-825-8494 

right away! 
 

 
Look for the Winter Edition of 

 

THE VILLAGE GREEN   

in your mailbox! 
 

 
 

 

 

 
 


